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Terms of Use

Information in this document is subject to change without notice and does not
represent a commitment on the part of Adaptive Micro Systems LLC. The software,
which includes information contained in any databases, described in this document is
furnished under a license agreement or nondisclosure agreement and may be used
or copied only in accordance with the terms of the agreement. It is against the law to
copy the software on any medium except as specifically allowed in the license or
nondisclosure agreement. No part of this manual may be reproduced or transmitted
in any form or by any means, electronic or mechanical, including photocopying and
recording, for any purpose without the express written permission of Adaptive Micro
Systems LLC.

This software program and associated documentation are provided in an "as is"
condition. In no event shall Adaptive Micro Systems LLC, its employees, directors or
agents be liable for any loss or damage whatsoever (including, but not limited to,
damages for loss of business profits, business interruption, loss of business
information, or other monetary loss) arising out of the use of or the inability to use this
software. By installing this software on your computer system you acknowledge that
you have read and understood these terms and that you accept them.

© 2003-2007 Adaptive Micro Systems LLC. All rights reserved.

Printed in Canada
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Chapter One

About KPIlworks Server

This chapter introduces KPlworks Server , including an introduction to not only the
product itself, but the documentation package as well. This manual contains an overview of
the product, detailed installation instructions, and KPlworks Administrator user instructions.
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Getting Started

This manual contains procedural and conceptual information about KPIlworks Server . It
was written to help Server Administrators install and maintain KPIworks and also to
provide them with a general knowledge of how the product works.

While it is not required that the user have any prior programming, marquee or
communications experience, the user should understand basic Windows concepts. These
concepts are described in detail in the KPIworks Administrator section of the manual. The
KPIlworks Administrator is used to maintain KPIworks Server and to perform everyday
tasks such as adding and removing marquees, and viewing transaction logs.

While this guide exists primarily as a user guide, it also contains detailed information
regarding the installation of KPIworks Server. The installation section takes you through
installation procedures, setup instructions and general requirements

The terminology used in this manual is defined in the glossary end of this manual.

Adaptive Micro Systems LLC
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Documentation Conventions

This document contains the following documentation conventions to help you navigate
through the manual and obtain a better understanding of the material.

Notes contain tips or reminders about procedural and conceptual information
within the manual.

Cross-references provide you with a link to further information about the section of
the document you are currently reading.

Using the Toolbar

The KPIworks toolbar allows you to quickly access menu items at the click of a button. The
toolbar is located below the menu at the top of the screen.

Toolbar
| Allows you to move up one folder level
(= Saves changes
3 New - Click to create a new Marquee Server,

= Device, Marquee, or Distribution List

Allows you to edit Devices, Marquees, and
Distribution Lists by just selecting on the
folder and clicking this icon.

Delete the current item

X

Allows you to enter in text to search for an
ik item by Device, Marquee or Distribution List
folder.
Changes how you would like to display items
= in the right pane — Large icons, Small icons,
List or Details

Print out a list of Devices, Marquees or

§| Distribution Lists

— Allows you to disable or enable devices or
ate marquees or put them into test mode

| (2] Launches online help file

Adaptive Micro Systems LLC
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KPIworks Server Features

KPIlworks Server is a marquee management system that allows you to easily communicate
to a variety of different marquees, using a simple generic language.

Main features of KPIworks Server include:

Simple, efficient installation wizards make for easy installation

Supports distribution lists

User-friendly maintenance of Devices, Marquees, Distribution Lists, etc.
Unlimited marquees and distribution lists

Detailed transaction logging and viewing of these logs.

Supports direct serial connections, TCP/IP sockets and RF connected marquees
Online reconfiguration of any engine setting or device/marquee configuration.
Supported Manufacturers/Models:

AdaptiveMicro - All models

Prioritization of messages

Adaptive Micro Systems LLC
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Chapter Two

Conceptual Overview

This chapter describes KPlworks Server in detall. It begins with a brief system overview
of the product and finishes with a general description of the main components of the
product.

This chapter was included to provide background information about the product itself and
some of the concepts involved in marquee displays. Users who are familiar with these
concepts do not need to read this chapter.

Adaptive Micro Systems LLC
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How It Works

KPIworks Server provides its clients with a single unified interface for dispatching text
messages to numerous different marquee manufacturers and models. The model and
connection method is irrelevant; KPlworks Server formats and delivers the message to
the marquee for you.

To accomplish this task KPlworks first utilizes a concept of a Device. A Device in KPlworks
is the physical path that the engine will utilize to connect to the marquee. Examples of
devices include serial ports, TCP/IP sockets, or RF connections via First PAGE Server .
Once the device is named and defined then it may be used to define marquees.

Using this device connection KPIworks Server communicates to the marquee using the
manufacturers’ protocol defined for the marquee.

For each marquee a unique marquee id is sent along with the message to identify the end
destination on the marquee network. The creation of a marquee in KPlworks Server
allows you to use a familiar name in place of the unique marquee network id, which is often
numeric and not easily remembered. The result of these message transactions are logged
within the KPlworks Server logs for later review.

Adaptive Micro Systems LLC
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KPIworks Server

KPlworks
Administrator

KPIworks

Server

Terminal Server

KPIworks
Client
200.1.1.y

e 200.1.1.2
I LAN/IP
200.1.1.3
COM 1 RS232/485

Signs connected
through COM1

A Thursday
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Configuration Examples

In this example marquee signs are configured using a number of different Devices:

terminal server, an IP connection, and COM 1 port on the Marquee Server. The following

are examples of the addition of Devices for each of these marquees:

Example A

Sign
connected
via terminal
server

Adaptive
Micro Sign

&y User: LABI0VAdministrator
The Host and Port on this Device will be the IP address and port used to connect to the
terminal server. The Adaptive Micro sign is connected via this terminal server:
[z KPIworks Administrator [_ (O x]
File Edit Wiew Tools Reports Help
B b | @ ew ~| 5 X | | | 5| state - | 3)
@ KPlwaorks Servers Details I Distribution Lists I Default Message I Previgw I
B8 test (LABID)
E‘D Devices Marquee -
= s TERMINAL s [adaptive micro
ElD Marquees o
: - [E) Adaptive Micra Destription:
7] Marguees Device: TERMIMAL =]
g D:lstribution Lists State: IEnabIed j
Clients I
Manufacturer: Indaptive Micro Syskems x
Model: [z15c =l
Setkings -
Address: IDI| Cueue Size: I 103: Priarity Threshold:I‘B 'I
Marquee Functions -
Clear | Refresh |
User: LAB10\Administrator 2

[z KPIworks Administrator

File Edit Yiew Tools Repaorks Help

I[=] 3

B H | Brrew -| & X | 86| E-| & see-| 2

@ KPIworks Servers
=88 test (LABLD)

E|{:| Devices
\ -3 TERMINAL
{:| Marquees
{2 Distribution Lists

{0 clierts

Dekails I

Device -

Marme: |TERMINAL
v Enabled

Communications -

Tvpe: ITCP,I'IP ~|
Host: J2o0.1.1.115 Part: |2on1|

Adaptive Micro Systems LLC
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Example B:

Sign
connected
via COM
port:

Adaptive
Alpha
Version 2
sign

[l KPIworks Administrator

File Edit Wiew Tools Reports Help

=] 3

| | Bonew | = X [ 48 |- S| st~ | )
F7] KPIworks Servers Details |
= kest (LAB10)
Devices Device
SERIGE Mame:  |SERIAL|
TERMIMAL
{:l Marquees ¥ Enabled
{0 Distribution Lists
L Clients Communications
Type: ISeriaI 'I
Hast: | part: [comi x|
Speed; I%DD 'l Flow Contral: INone 'I Byte Size: IB 'l
Parity: INone 'l Skop Eits: |1 'l

[z KPIworks Administrator

File Edit Yiew Tools Reports Help

EE"J- User: LABLOVAdministrator 2

IS[= E3

B & Eyew - X | 84| E-| S| state - )
@ PIworks SErvers Details | Optionsl Ciskribution Lists I Default Message I Presigs |
E-EE test (LABID)Y
{0 Devices Marques
= sertaL Mame: [prepazs
=3 Marquees
Descripkion:
Device: SERIAL j
State: Enabled e
{13 pistribution Lists T;pze_ lenabie [
""" {7 Clientks
Manufacturer: |Adaptive Alpha Yersion 2 j
Madel; BIGDOT 26Char =
Setkings -
Address: |01| Queue Size: I 103: Prriarity Threshold:l? 'l

Marquee Functions

Clear | Refresh |

User: LAB1DVAdministrator -

More than one sign may connect through the same COM port

Adaptive Micro Systems LLC
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Sign
connected
via RF
connection
to
FirstPAGE:

g KPIworks Administrator

KPIworks Server

=] B3
File Edit View Tools Reparts Help
|n|&uew '|X|M|"|§| Statev|@
:ﬁ kPIwarks Servers Dietails I
-8 rest (LABLD)
=1 Devices Dewice
. B3 FIRSTPAGE Mame:  |FIRSTPAGE]
SERIAL
- TERMINAL ¥ Enabled
D Marguees
{0 pistribution Lists Camrunications -
(3 Clients Type: [Firstpace -]
Hast: fincalhost port:  [003

Destination: |5_BURNS

=

@ User: LABLOVAdministrator 2

Select the Host and Port of the FirstPAGE Server in the Host: and Port: fields, then select
a FirstPAGE Destination from the drop down menu. The message will be sent to this

destination.

Adaptive Micro Systems LLC
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The KPIworks Administrator

The KPIworks Administrator utility program is used to configure and control the KPlworks
Server engine. System managers responsible for KPIworks are the intended users of
KPIworks Administrator.

The features and operations that can be performed with KPIworks Administrator include
adding, modifying, deleting, listing, printing database information, viewing logs and
changing server configurations, etc.

A copy of KPlworks Administrator is included with the KPlworks Server software; it will be
installed automatically when you install the server. The KPlworks Administrator program
can be accessed from the server machine, or any administrator workstation by purchasing
the KPlworks Administrator Kit. This document does not describe the use of the KPlworks
client software modules; they are contained in a separate manual.

Adaptive Micro Systems LLC
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Chapter Three

Installing KPIworks Server

This chapter describes the KPlworks installation and setup process. It begins with
general installation requirements and concludes with procedural information about
installing the server software.

Adaptive Micro Systems LLC
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System Checks and Requirements

Before beginning the installation, it is important to determine the hardware and software
requirements necessary for KPIworks Server to run efficiently. The following list
contains decisions that must be considered before the software is installed:

Installation Considerations
System Requirements
One of:

Microsoft Win2K (SP4+)
Microsoft Win2K3
Microsoft WinXP (SP1la+)

Applications

FirstPAGE Server (optional)
Disk Space

200 MB
Display
800x600

Drivers

TCP/IP
MDAC V2.7SP1 (SP1+)

RAM
128 MB

Additional Requirements

Determine the KPIworks Server Host Name you will be connecting to

Determine which disk drive/directory your KPlworks server software will reside on.
Determine the manufacturer and model for each marquee to be connected to the
server.

Determine the marquee address, and any TCP/IP addresses and ports required to
connect to all marquees.

Configure any serial ports to function with standard communications software for the
platform you are using (i.e. HyperTerminal) and ensure any TCP/IP hosts can be
reached from your server without the need of a proxy server.

Adaptive Micro Systems LLC
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Performing the Installation

This section of the manual contains procedural information about the actual installation of
KPIworks Server. It assumes that you have no prior knowledge of the software, but does

require a basic knowledge of the Microsoft Windows environment.

KPIworks Server Installation
To Install KPlworks Server:
1. Run SETUP.EXE from KPlworks Server .

x
Welcome!
Thiz installation program now will install KPlwarks -
Server.
Fress the Continue button to start the installation. You
cah prezs the Cancel button now if you do hot want to
inztall KPlworks - Server at this time.

Confinue I Cancel |
2. You will be prompted for the installation destination directory:
x

Select Destination Directory

Fleaze zelect the directon where Server filez are to be
inztalled.

"Free Disk Space After Install™' iz bazed on your current
zelection of files toingtall & negative number indicates that

zpecified drive.

there iz not enough dizk space tao install the application to the

C:\Program Fileshkpiworks\Server

Browsze. . |

Free Dizk Space After Install:
Current Free Dizk Space:

F2VE73 K
731328 k

Finish

< Back |

Cancel |

3. Once complete click OK to complete the installation and restart your computer.

The computer must be restarted before the KPlworks Server can be configured or

operated. After restarting Windows, select Start — Programs — KPlworks —
Server — Administrator to configure your KPIworks Server.

Adaptive Micro Systems LLC
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Starting KPIlworks Server Administrator
KPIlworks Administrator will automatically be installed with KPIworks Server .
To start KPlworks Administrator:

1. From the Start menu, select Programs - KPlworks — Server — Administrator
The first time you start the Administrator the following screen appears:

KPlworks 1ol x]
Administrator | Ele Edit wew Took Reports Help
=R =M=l
¢ arne Description | Forkt | DevicEL
4| | i
|D Marguee Serveris), 0 selected | | &

There are two ways to navigate through these screens to enter information:
Use the mouse to click on the desired area.

Use the arrow keys to expand and navigate the tree view.
Tab to navigate down fields and the Shift + Tab keys to navigate up fields.

Adaptive Micro Systems LLC
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Chapter Four

Configuring KPIworks  Administrator

Before you can begin using KPIworks Administrator , you must configure the various
settings that control the interface to the server, and you must add at least one server to the
administrator. The steps required include: adding a KPIworks Server , defining file paths,
server communication options and licensing options.

This chapter contains information regarding the setup, configuration and maintenance of
KPlworks Administrator

Adaptive Micro Systems LLC
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Configuring the KPlworks Administrator

Once you have installed KPIworks Administrator on your machine, you must configure
it to your desired needs. Once configured you must add your KPIworks Server to it before
you can maintain the server.

Adding a KPIworks Server

KPIworks Server includes one Administrator license key that allows the addition of a
single server. Additional licenses may be purchased that allow multiple servers to be
added and maintained from your KPlworks Server .

KPIworks Server also has a licensing requirement.

The Server configuration process includes a Details tab, which defines the connection from
the KPIworks Administrator to the KPIworks Server allowing it to maintain a server, as
well as a Settings tab that contains the server’s configuration options, which tailor the
operation of the server engine.

Configuring a KPIworks Server:

1. Select KPIworks Server in the tree view then click the New icon in the toolbar. You
will be prompted to select an ODBC Machine Data Source. If you are configuring
KPIlworks Administrator supplied with KPIworks Server then the installation kit has
already created this DSN. Simply select the KPIworks Server DSN from the
Machine Data Source tab, and click OK.

The KPIworks DSN is KPISERVER.

Select Data Source x|

Fleaze zelect the 'Marquee M anager Server' D atabaze.

Drata Source Mame D ezcription

zaudbla System  Kemma Software Bridge [Evaluat

kzaudzmb System  Kemma Software Bridge [Evaluat
kzbrdgh0 System  Kemma Software Bridge [Ewaluat
kzzamphl System  Kemma Software Bridge [EvaluatJ
b <140 System

b awirno_LABT2 System

kA AD R IM System

MMGWCOPA_LARS System _|;|
1| | »

& Machine Data Source iz zpecific ta this maching, and cannat be zhared.
"Uzer' data sources are specific to a user on thiz machine. "System data
gources can be uzed by all users ok thiz machine, or by a systerm-wide service.

(] I Cancel

2. By default there is no username and password required for this DSN.

The following screen appears:

Adaptive Micro Systems LLC
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KPIworks [t KPIworks Administrator ]
Server Details IEiIe Edit Miew Tools Reports Help

| & e [ = X s =& @

@ kPIwarks Servers Details | Settingsl Security

Server -

Hist Marne: ||

Descripkion: I

Connection -

Dgh: JEPTwSERVER EI

User Mame: I

Password: I

Logging -

Log Path: I ﬁl

ﬁ Enter the path this workstation requires to access the
logs directory on the current Marquee Server,

I | | 4

3. On the Details tab, enter the Server Host Name and Description. The Host Name
must be a TCP/IP resolvable name which must be in your DNS server or your local
host file and can be reached from the Administrator workstation. The description
field can be any text field the administrator wishes to refer to the server as.

4. Enter the Log Path required to access the logs directory on the current KPIworks
Server. In most cases, if the server is locally installed this path will be a drive letter
based directory specification (e.g.: C:\Program Files\KPlworks\Server\Logs)). If the
server being managed is not the local server then this path will most likely be a
UNC path ( \server\share\directory\), which provides access to the remote servers
log directory. (e.g.: \KPlworksserverl\mmserver\logs\).

Adaptive Micro Systems LLC
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KPIworks
Server
Settings

KPIworks
Server
Settings

[l KPIworks Administrator

_iol x|
‘ File Edit Wiew Tools Reports Help
== TR =R
F#] KPLwarks Servers i__p_g_t_gils_fl Settingsl Securityl
Server -
Host Marne: ILF\BID
Descripion; ItESt
Connection -
DS JKPTWSERVER @'
User Mame: I
Password: I
Lagging -
Log Path: IC:'l,PrUgram Files\kPTworks)Server| LGS Eﬁl
A Enter the path this workstation requires to access the
logs directory on the Marquee Server 'LABLD",
| | | 7

After completing the details tab click on the Settings tab to configure the server
options. If the server has never been configured before then the contents of the
Settings tab will be defaults, if the server is already configured and operational

then these fields will be filled with the current servers settings. Below is the default
Settings tab form:

[g KPIworks Administrator
JEiIe Edit Miew Tools Reports Help

|| || &Eew -| & X8 [E-&(@

7] KPTwarks Servers

=10l x|

Details  Settings | Securityl

Server -

TCPJIP Port: IBDI 1

License key: | $|
Delay)Timeout -

Clack Sync: ISGDD

Logging -

Log Days: I 7 LogLevel: I 0 Mazimum Log Space: I 503: (MB)

Log Path: I ﬁl

& Enter the path whera the Marquee Server will stare

its log files. This path should reflect a directory on the
server 'LAB10D'.

6. TCP/IP Port: defaults to 8011. Enter in the valid KPIworks Server License Key.

Adaptive Micro Systems LLC
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KPIworks
Administrator
Security

Enter the Clock Sync: delay/timeout. Default is 3600 seconds (1 hour). This
setting will automatically sync the internal marquee times to that of the Marquee
server.

It is recommended that you run NTP (Network Time Protocol) on the
Marquee Server machine to set the clock. This will ensure the accuracy of
all marquee internal times as well.

Enter the number of days in the Log Days field that the log file will be kept before
being purged. Default is 7 days. The Log Level field is for use at the request of
Adaptive. In the event of any problems with the Gateway, Adaptive may request
additional levels of logging to assist in problem solving.

To prevent the log files from consuming too much drive space, you can specify
how much space to allot to the log file in the Maximum Log Space field. Default is
50 MB.

The Log Path field is a path specification, local to the actual KPIworks Server ,
which contains the directory where the KPlworks Server will store its log files.

Click on the Security tab to configure the desired level of security on the KPIworks
Administrator.

g KPIworks Administrator =[O0 x|

‘Eile Edit | Wiews Tools Repaorts Help

Bl e -5 X (#E- &2

@ KPIworks Servers Details I Settings
Security -
Mods: [oeFaLLT =]

| I | 4

10. Mode of None leaves security disabled. Basic mode enables Adaptive security

and Ford Mode enables Ford specific security.

11. Click the Save icon in the toolbar to save your Server options. Your screen will

look like this:

Adaptive Micro Systems LLC
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KPIworks
Server

gt KPIworks Administrator

JEiIe Edit “iew Tools Reports Help

=101 ]

B e - 2 X #E- S|

C7] KPIwarks Servers
-8 test (LAB1O)
{1 Devices JErVer

Settings I Security I

D Marguees
{0 Distributian Lists

D3kl

Password:

Lagging

Hosk Mame:

D Clients Description:

Caonneckion -

LagLo

|test

User Mame:

[PrwSERVER

g

Log Path:

|C:'|,F‘rc-gram FilesikPIwarks! ServeriLOGS)

ﬁ Enter the path this warkstation requires to access the

logs directory on the Marquee Server 'LAE1D"

Y

@ User: NCTIdgouchie

When KPlworks Server is down (i.e. incorrect host name, cannot reach DNS server, LAN
connection between the KPlworks Administrator machine and the KPIworks Server is down
etc.) a red X shows by the root node of the server in the left tree view. Devices and
Marquees may still be added while this connection is down.

Adaptive Micro Systems LLC
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Chapter Five

Using KPIlworks Administrator

The KPIworks Administrator user interface is conveniently displayed in a tree view that
when expanded shows a Devices folder that enables the user to add information about the
devices that the server will use to communicate with the marquees.

It includes a Marquees folder and a Distribution List folder that serve as shortcuts to
already configured Marquees and Distribution Lists, allowing the user to quickly locate this
information without knowing the device that supports them.

This chapter contains procedural information about using KPlworks Administrator . It
begins with an overview of the functionality of KPlworks Administrator and concludes with
procedural information about performing everyday Administrator tasks.
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Creating and Modifying Devices

The Devices folder allows you to add and maintain all devices and device related
information such as device type and communication settings. Devices are the physical
connections, which the server will utilize to connect to the various marquees. Devices must
be configured before any marquees may be defined.

Adding a Device

To add a device to the database:

1. Right click on Devices in the tree view and select New Device or select the
Devices folder and click the New icon in the toolbar.

The following screen is displayed:

KPIworks
Server Devices

2. Enter a Device name in the Name: field. This is a logical name utilized by the
administrator to refer to this physical device. For example a serial port may be
called: SERIALCOMSG or a TCP/IP connection: IPSERVER10

3. The Enabled field allows you to disable or enable individual marquees to make
firmware changes or for testing purposes.

4. Select the type of device you are using from the Type: drop down list. The type of
device can be TCP/IP for an Internet connection, Serial connection (by serial
cable), or FirstPAGE for RF connections.

5. For Device Type of TCP/IP you must specify the host name or IP address and port
used to connect to the terminal server or LAN.

6. For Device Type of Serial, you must specify the Port that the device is connected
to, as well as port speed, flow control, byte size, parity and stop bits. The Flow
Control option defines the way that the devices throttle the flow of send and
receive data. Select Hardware to use the devices hardware flow control method or
select Software to use the devices software flow control method. The default value
for this field is N/A.

7. For Device Type of FirstPAGE, you must specify the Host and Port of your
FirstPAGE Server as well as a destination to send the message to.
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8. Click the Save icon to save your new Device. The Device has now been added to
the Devices database and is ready to have one or more Marquees assigned to it.

Adaptive Micro Systems LLC
32



KPIworks Server

Viewing and Modifying Devices

To view or modify device information:

Viewing or
modifying
device
information

1. On the Devices folder, select a device from the list and click the Edit Device icon
in the toolbar.

2. The configuration settings and information for the selected device are displayed.

Click on a field to edit the device information.

3. You may disable the device by selecting the Disable icon in the toolbar . The

device will then appear in the left pane with a yellow X by it. This feature is
beneficial if the device needs maintenance and needs to be disabled for a period
of time. To enable, simply select the device and click the Enable Item icon in the

toolbar

4. Click the Save icon in the toolbar to save any changes.
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Deleting a Device

You will not be able to delete a device if a Marquee is still assigned to it. Otherwise, device
entries can be deleted entirely using the KPlworks Administrator application.

To delete a device:

1. Select the device you want to delete either from the tree view or the device list on
the left pane of the screen.

2. Click the Delete icon in the toolbar to remove the device from the list.
3. Click Yes to confirm the deletion. The device will now be removed from the list.

Once a device has been deleted, it cannot be retrieved. The only
way to restore it is by adding it back into KPlworks Administrator (see
the "Adding a Device" section in this chapter for more details).
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Creating and Modifying Marquees

The Marquees folder contains information pertaining to marquees, and their configuration
settings. By selecting the marquees folder it allows you to add marquees to the system and
modify their settings.

Adding a Marquee

Before using KPlworks , you must add one or more marquees to a device. This includes
the name, manufacturer, model, address etc.

To add a marquee to the database:

1. Expand the Devices folder, and select the Marquees folder. Right click and select
New Marquee or select the Marquees folder and click the New button on the
toolbar. The following screen is displayed:

Marquee
Details Tab

2. On the Details tab, enter the Marquee Name and description in the Name: and
Description: fields. The name will appear in KPlworks Client exactly as it is
typed in this field.

3. Select the Device that this marquee will be connected to.

4. The State field allows you to disable, enable or set individual marquees to test to
make firmware changes or for testing purposes. Marquees will be displayed in the

tree view with the appropriate icon: for a disabled marquee and fora
marquee that is in test mode.

5. Select the Manufacturer and Model of marquee from the Manufacturer: and Model:
drop down lists.

See Appendix A * Sign Properties ' for a complete list of supported
manufacturers and models.

6. Enter the marquee address in the Address: field. The following table illustrates the
required address values for each type of Manufacturer:
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10.

Distribution
Lists Tab

11.

Manufacturer Address format
Adaptive Alpha Version 2 2-digit hex from the display.

Range = 00-FF

Adaptive Micro Systems 2-digit hex from the display.
Range = 00-FF

NETCON Native Unit Fixed length 4-character address

field. First two bytes represent group,
second two bytes represent unit.
Valid values 00-FF. All characters in
uppercase.

Select Queue Size: for the marquee selected. Queue size determines the number
of live messages that will be displayed on the marquee at one time. Default queue
size is 10 messages for all.

Select the Priority Threshold for this sign. The Priority Threshold determines the
order that messages sent to the sign will be displayed. High priority messages are
a threshold of one and low priority message will be a threshold of nine. Default
Priority Threshold is set to nine.

For example, if your marquee has a priority threshold set to three, all messages
with a priority of three or higher (and only those messages) will be displayed.
When they have been acknowledged and are no longer being displayed, any other
messages with a lower priority will then start displaying on the marquee.

Priority Threshold is a licensed feature that will only be enabled if
purchased.

On the Distribution Lists tab, select the distribution list that you wish to add the
marquee to.

On the Default Message tab, enter in the message that will be displayed when no
active messages are being sent. This screen will change to reflect the number of
available lines and attributes depending on the Manufacturer and Model selected.
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Default
Message Tab

12. Select the message attributes for color, font, scrolling and mode.

13. KPIlworks allows you to configure multiple colors and modes per line. E.g. <COL-
RED>Marquee<COL-GRN>Message entered in the Text field would display the
word Marquee in red and the work Message in green.

14. KPlworks Server allows you to configure additional insertion tags to the default
message. The tags available at this time are <TIME> and <DATE>. The insertion
tags must be included in brackets and must be all upper case.

15. The Preview tab displays what is currently being played on the display; any slots
that have been entered with KPIworks Client.

Preview Tab
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Cloning a Marquee

If you have many marquees that must be added to the Administrator, KPlworks
Administrator allows you to clone marquees. This eases configuration by cloning all
details/attributes of a particular marquee.

To clone a marqguee:
1. Select the marquee you wish to clone. Right click and select Clone Marquee .

2. A new configuration screen will be displayed. The only information that is not
cloned is the Name, so no duplicates are created, the Device, allowing the user to
select the device they wish the new marquee to be connected to, and the address.
All other information, including the default message and attributes are cloned as
well.

3. Click the Save icon to save your new cloned marquee.
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Viewing and Modifying Marquees

To view or modify marquee information:

1. Onthe Marquees folder, select a marquee from the list.

Viewing and
Modifying
Marquees

The configuration settings and information for the selected marquee are displayed.
Click on a field to edit the marquee information.

You may disable the marquee or put it in test mode by selecting the State icon in

the toolbar. The marquee will then appear in the left pane with a yellow X by

it to show it is disabled, or a yellow T to show it is in test mode. This feature is
beneficial if the marquee needs firmware installed or for testing purposes and
needs to be disabled for a period of time. To enable, select the marquee and click

the Enable Item icon in the toolbar

Click the Save icon in the toolbar to save any changes.

The Clear button allows the marquee to be cleared of all messages,
including those sent through KPIlworks Client. The Refresh button allows
the marquee to be refreshed, maintaining all current messages that are
currently displayed or in the queue to be displayed.

Once the information has been saved, you cannot revert to the old
information. The only way to get it back is by changing it again.
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Deleting a Marquee

Marquees can be deleted through the Device in the tree view or by using the shortcut
folder called Marquees that lists all configured Marquees and is intended for a quick
access to Marquee information.

To delete a Marquee:
1. Select the Marquee you want to delete. The Marquee information should then
appear on the right-hand side of the screen.
2. Click the Delete icon to remove the marquee from the database.

Once a Marquee has been deleted, it cannot be retrieved. The only
way to retrieve it is by adding it back into the database.

The Marquee Client must be refreshed after any changes are made in
the Marquee Administrator. When deleted, the marquee will be
cleared of this message.
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Creating Distribution Lists

The Distribution Lists folder allows users to add configured marquees to distribution lists,
allowing the same message to be sent to multiple marquees at the same time. KPIworks
Client applications provide the ability to compose messages and send them to a marquee’s
distribution list.

Adding a Distribution List

To add a distribution list:
1. Click on the Distribution Lists folder, right click and select New Distribution Lists
or click the New icon in the toolbar. The following screen is displayed:

Creating
Distribution
Lists

2. Enter in the Name and Description of the Distribution List.

3. Select which Type of Distribution List to create. Type Standard includes all
Adaptive Micro marquees that are not cell-based.

4. From the list of Marquees, select the marquees you would like to add to this
distribution list.

5. You can filter out the marquees list by selecting the Show selected marquees only
button.

6. Click on the Preview tab to display what is currently being displayed on the
marquees in that distribution list.

7. Click the Save icon to save distribution list details.

Adaptive Micro Systems LLC
41



KPIworks Server

Clearing Transactions

The Clients folder allows users to clear transactions initiated from various clients such as
KPIworks Client or any gateway applications that are utilizing the server. This allows the

administrator to clear any transactions should the client or gateways lose connection with
the KPIworks Server.

Clearing a Client Transaction
To clear a transaction:

1. Click on the Clients folder. A list of current transactions for each client is displayed
in the right pane:

Clearing
client
transactions

2. Select a Client from the left tree view to see the details of each transaction. The
Transaction Count displays the total number of transactions currently active on
each client.

Clearing client
transactions
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3. Click the Clear button to clear all transactions on the selected Client, displaying the
default message for that Client.
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Chapter Six

Configuring Options and Viewing the Logs

The KPIworks Server allows you to configure various options such as data entry details
and marqguee attribute defaults, as well as setting options for the server should it be
unavailable at startup.

Logs are also available for viewing as a means of troubleshooting, providing details on any
problems or errors.
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Configuring Options
The Optionsmenu allows users to set KPlworks Server details.

To configure Server options:

1. Click the Tools menu then select Options . The following screen is displayed:

Configuring
Options

2. The General options display the Server Data Source as well as the license key.
This key determines the number of servers that can be configured.

3. KPIlworks Server gives you the option to reload the server with any additions, edits
or deletions automatically or when requested by the user. Select if you would like
the server to automatically reload after every change or to perform the reload only
when requested. If you choose to reload after every change, the reload will take
place when the Save button is clicked. If you choose to reload only when
requested, you will be prompted that there are data changes that the server needs
to notified about and have the option to either send the reload before closing or
close the system without reloading the changes:
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4. Click on the Preferences tab to control the KPIworks Administrator data entry
preferences. You may control prompting in the event no default was supplied, and
you may control the default attribute handling for marquee attributes.

Configuring
Preferences
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Viewing the Log File
KPIworks Administrator allows you to view the log files associated with the various
components of the software. The log files contain an accurate history of every transaction
and modification made to the database. Log files are important because they ensure the
integrity of the data and provide a means of data recovery.
To View the Log File:

1. Select View Log option from the View menu to display the following screen:

Viewing the
log files

2. Double-click the log entry for further information.
3. Click the Filters button and choose viewing options to display only the desired
information.

Filtering log
information
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4. The Events On: field defaults to the current day.
The Status Message field can be used to search for a portion of the message in the log.

Only certain characters may be used in this field. The common search characters are as
follows:

Character Match made Example

? Any single character Text in the log is
ABC, DBC and XYZ.
If ?BC is used in the
Status Message
field, only ABC and
DBC will be
returned.

* Zero or more characters  *Initiated* in the
Status Message field
would return all log
items with the word
‘Initiated’

# Any single digit (0-9) Text in the log is
Devicel, Deviceb,
Device8, DevicelO.
Keying in Device# in
the Status Message
field, will return
Devicel, Device5,
and Device8.

When matching the special characters left bracket ([), question mark (?),
number sign (#), and asterisk (*), enclose them in brackets.

Ex. to find all log items that start with [ you need to enter in [[]* in the Status
Message field.

5. Select the Automatic Refresh option to automatically refresh the log file based on
the seconds specified.
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Chapter Seven
Configuring and Using Security

The KPIworks Server comes equipped with security options that allow the
administrator to configure users with limited security access. It is conveniently displayed
in the tree view under the Tools folder when enabled.
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Enabling and Configuring Security

If security is enabled when the KPIworks Server is configured, either by selecting Basic or
Ford mode security (specific only to Ford users), a Usersfolder appears under the Tools
section of the tree view.

The Users folder allows the administrator to add destinations with limited access to various
user applications.

Adding a User to Security

1. Click on the Tools folder then select the Users folder. Right click and select New
User or click the New icon in the toolbar. The following screen is displayed:

Creating Users
in security
mode

2. Enter the Username for this account. This must be the Windows login username.

The first user entered must be an administrator with Admin security. The
last user removed must also be an Admin.

3. Select the Domain from the drop down list of available domains.
4. Enter a Password for this username then confirm password.

5. Select the level of security this user will have. Admin access gives users access to
both KPIworks Administrator and KPIlworks Client. Default access gives users
access only to KPIworks Client.

6. Enter any additional notes on the user in the Notes field.

7. You will now be prompted for a User ID/password and a valid Domain name before
you can access KPlworks Administrator.
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KPIworks
Administrator
Security Login
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Chapter Eight

Running the Database Converter

The KPIworks Server comes equipped with a database converter that allows the
administrator to upgrade a database if they are running an older version of the gateway.
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Upgrading the Database

If upgrading from a previous version KPlworks Server, the administrator and server
databases must both be converted to run with the new version.

Running the Convert Option

1. From the Start menu, select Programs — KPlworks Server — Database Conversion.
This will launch the Conversion Wizard.

Be sure to stop the KPIworks Server service via Control Panel before
running the database conversion.

Database
Conversion
Wizard

2. The Conversion Wizard will display a summary of changes that will be made to
your FirstPAGE Gateway for OPC database, including the current version that is
running and the target database.
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Database
Conversion
Wizard

3. Click Start to run the converter. Conversion results will then be displayed.

Database
Conversion
Wizard
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Chapter Nine

Technical Assistance

Support Contracts

You may purchase a support contract for KPlworks Server. Various levels of support are
available. View the KPlworks web site (www.KPIworks.com/support
<http://www.KPIworks.com/support> ) and submit an inquiry for the product you are using.

For all support related issues, please provide the version of the software that you are
running. This may be verified by browsing your Start menu, Programs, then selecting the
application in question (i.e. KPlworks\Server), then selecting Version Info. This will provide
the install kit version that is currently running.

Help Desk

To reach our help desk please use one of the following methods:

Telephone: +1.800.558.7022 x519

Fax: +1.414.357.2029

Web: www.KPIlworks.com <http://www.KPIlworks.com/support> - Customer Care
E-Mail: support@KPlworks.com <mailto:support@KPIlworks.com>

Please have your version information and support contract or product license key ready
before calling or include it in your correspondence. Support is free for product trials and for
the first 30 days of product ownership. To view your product version select Start —
Programs — KPIlworks — Server — Version Info.
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Glossary
Administrator

Typically a GUI application, this component facilitates configuration and monitoring of a

server engine. If changes are made to the server configuration the administrator notifies
the engine to reload its running configuration either automatically or on user demand. An
example of an administrator component is FirstPAGE Administrator.

This administrator allows you to maintain the FirstPAGE server's engine configuration.

Administrator Kit

An administrator kit contains the product's administration component only. After installing
this kit on a workstation you may utilize any of the features of the Administrator component.

Client

A client component utilizes the facilities of a standard NETCON server. Typically a GUI
application, this component provides a user-friendly interface of the available services
offered by the server engine. An example of a client tool would be FirstPAGE Client, which
presents the user with a list of known messaging destinations and allows them to send
messages to one or more destinations.

Cycle

The time period defined for the display of Controller 980 templates, allowing the display of
multiple screen templates in sequence.

Device

A KPlworks Server device is a hame assigned to a physical connection point on the
server, which will be used to establish a connection with a marquee.

Distribution List

A KPlworks Server distribution list is a collection of marquees, which can be sent a
message with a single transaction. Similar to an e-mail distribution list, a client which
initiates a transaction with a distribution list will automatically send the same message to all
associated marquees.

DSN

A DSN, Data Source Name, is the name assigned to an ODBC driver and configuration
information that allows an ODBC enabled application to connect to a data source.

Engine

An engine component implements a unified interface to a set of common, related
protocols. The engine provides services to clients and gateways such that a common
interface may be used to manipulate many different types of devices. Engines are
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administered via Administrator components and are utilized by clients, gateways or use
written components.

Marquee

A sign display that serves as a visualization communication tool, providing the means to
display time, date and message text such as production counts, and what areas of a plant
are experiencing problems.

ODBC

The ODBC protocol is an implementation of the Microsoft ‘Open Database Connectivity'.
The ODBC API is utilized to access the KPIlworks configuration database.

Priority Threshold

The importance or priority that can be placed on each message sent to the marquee sign,
with one being the highest priority and nine being the lowest priority.

Queue Size

The number of live messages that will be displayed on the marquee at one time.

Server Kit

A server kit typically contains the server engine and administrator components. In some
cases a client component is also included with this kit. The server kit is usually installed on a
centralized host and is utilized by one or more clients or gateways. An example of a server kit is
FirstPAGE Server. This kit contains the FirstPAGE engine, administrator and client.

Stack Light

Stacked lights typically used to display colors in a vertical grid pattern from one to five
lights high. They may be used to show if a station is experiencing a problem then turn a
light on to alert personnel.

Template

A user formatted guide or page of configured marquees, allowing you to display a page at
any given time without the need to customize each marquee.
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APPENDIX A — Sign Properties

ADAPTIVE ALPHA VERSION 2 *

Model Color Font Scrolling Flashing Notes
BIGDOT Tri-color Double Height Supports
13Char Rollup
BIGDOT Tri-color Small, Fixed Supports
26Char Width, Bold Rollup
Adaptive Micro Systems*
Model Color Font Scrolling | Flashing | Notes
ALL Tri-color | Small, Bold, Fixed
Width
Beta-Brite Tri-color | Small, Bold, Fixed
Width
BIGDOT Tri-color | Small, Bold, Fixed
Width
BIGDOT _ Tri-color | Small, Bold, Fixed
26Char Width
PPD Small, Bold, Fixed Red and green
Width models
215 Tri-color | Small, Bold, Fixed
Width
215C Tri-color | Small, Bold, Fixed
Width
320C Tri-color | Small, Bold, Fixed
Width
330C Tri-color | Small, Bold, Fixed
Width
4080C Tri-color | Small, Bold, Fixed
Width
4120C Tri-color | Small, Bold, Fixed
Width
4120R Red Small, Bold, Fixed
Width
4160C Tri-color | Small, Bold, Fixed
Width
4160R Red Small, Bold, Fixed
Width
4200C Tri-color | Small, Bold, Fixed
Width
4200R Red Small, Bold, Fixed
Width
4240C Tri-color | Small, Bold, Fixed
Width
4240R Red Small, Bold, Fixed
Width
7120 Tri-color | Small, Bold, Fixed
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Width

7160 Tri-color | Small, Bold, Fixed
Width

7200 Tri-color | Small, Bold, Fixed
Width

7200_4Line | Tri-color | Small Caps

9120 Tri-color | Small, Bold, Fixed
Width

9160 Tri-color | Small, Bold, Fixed
Width

9200 Tri-color | Small, Bold, Fixed
Width

9240 Tri-color | Small, Bold, Fixed

Width

NETCON Native Unit *

Model

Color

Font

Scrolling

Flashing

Notes

Clock

N/A

N/A

X

X

Displays time only

Counter

Red

Fixed Width

X

X

- Numeric only

- Max. 8 digits

- # of Characters can
be set on the Options
tab in Marquee
Administrator

Marquee

Multi-Color

Fixed Width

- Supports Rollup
- # of Lines and
Characters can be
set on the Options
tab in Marquee
Administrator

Sounder

N/A

N/A

N/A

N/A

255 Tunes
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APPENDIX B — Additional Options for Various Marquee
Models

Adaptive Alpha Version 2 Models

The Adaptive Alpha Version 2 BigDot includes additional options that are not available on
other marquee models. It allows the user to select how long to display a message as well
as scrolling options.

1. The Options tab allows you to configure marquee options.

Creating
Adaptive Alpha
Version 2
model
Marquees

2. Select the number of seconds you wish to display the message from the Message
Viewing Duration drop-down. Default is 3 seconds.

3. Select the Scrolling Support option that you wish to use for this marquee. Available
options include Enabled, Disabled and Roll-up.

4. Max Viewing Duration indicates the maximum time in seconds the message will be
displayed.

5. The Keep Alive Interval ensures a packet is sent to the marquee after the specified
seconds. If all messages are cleared to the marquee, it will send a keep alive
packet so the marquee does not disconnect. If setto 0, no packet will be sent.
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NETCON Native Unit Models

The NETCON Native Unit includes additional options that are not available on other
marquee models.

Creating
NETCON
Native Unit
model
Marquees

1. The Options tab allows you to configure marquee options.

2. Select if you want the marquee to display in 12 or 24 hours from the Time Display

drop-down.

3. The Delivery Confirmation field allows you to enable or disable confirmation that

the message was delivered to the appropriate display. If delivery was
unsuccessful, the logs will indicate that the delivery failed.

Adaptive Micro Systems LLC
65



KPIworks Server

APPENDIX C — Installing KPIworks Administrator

Before installing and configuring KPIworks Administrator, there are two steps that must be
completed. The first is to share the files on the server running KPIworks.

Sharing an Application Folder

In the Program Files folder, chose your Application folder — in this case, KPIlworks. Expand the
folder and chose the part of the application you would like to share. In this example, KPlworks is
the folder we want to share because it contains the data and log files.

Right click on the folder and chose Sharing and Security. You should get the following screen:
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Chose “Share this folder” and chose OK.

Click on the Permissions button. Make sure under Allow is checked off for Everyone, then hit OK.

Under the Security tab. Make sure under Permissions for Administrators, Full Control is checked
off under Allow.
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Choose OK. An icon of a hand holding a folder will appear before the folder you are sharing.
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Creating a DSN

The first step is to create a DSN. This must be done on the computer where the KPlworks
Administrator will be installed.

In Windows, go to Start > All Programs > Administrative Tools > Data Sources (ODBC). Chose
the System DSN tab:

Chose the Add button to get this screen:
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Double click on Microsoft Access Driver (*.mdb) and enter the name of the application, adding the
name of the computer where it resides.

Chose Select to choose an existing database. The following screen will appear:
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In the Database Name, type “\\", the name of the computer the Server Application is installed on,
“\" the share name, “\" data “\" and the name of the database file.

Click OK and your new DSN name should appear.

Click OK.
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Setting up the Administrator

1. Run SETUP.EXE and the following screen will appear:

KPlworks
Administrator
Install

2. Click Continue. During install, you will only be prompted for the install directory:

KPlworks
Administrator
Install

3. Select Finish. When you launch KPlworks Administrator, you will get the following
screen:
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4. Select “New “ and the following screen will appear:

5. Choose the DSN that you created in the previous steps, and hit OK.

6. On the Details tab, under Server, enter your Host Name. This should be the name
of the computer your Server Application is installed on. Enter a description. Then
enter a Description.

7. Select the Log Path required to view the log on the KPIworks server machine. E.g.
\\Lab10\KPIworks\LOGS\
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8. The Settings tab displays the details from the KPIworks Administrator. These
fields are greyed out and cannot be edited from the remote Administrator. The
Security tab displays the security type that was set up on the server. These fields
are greyed out and cannot be edited from the remote Administrator.

9. Click the Save icon in the toolbar to save changes.

10. The Items and Events that have been configured on the KPIworks server will now
be displayed. You may now begin to add or configure routing rules from the
KPIworks Administrator.
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